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[bookmark: _Toc303784797][bookmark: _Toc423441490]

The Thesis Template
[bookmark: _Toc379398036][bookmark: _Toc418520280][bookmark: _Toc423441491]Introduction
This document serves as a set of instructions for use with the SFU Library thesis template (http://www.lib.sfu.ca/help/writing/thesis/templates). 
[bookmark: _Toc423441492]About the Thesis Template
The SFU Library template is a Word file (.docx) designed to assist students in preparing theses, dissertations, extended essays, and projects. 
Features of the template can save time and labour when preparing your document: 
The template contains styles for formatting all the parts of a thesis: headings, paragraphs, quotes, captions, figures, tables, and so on. Using styles helps to keep formatting consistent (see 1.3, About Word Styles).
Headings, figures, and tables can be numbered automatically.
The Table of Contents, List of Figures, and List of Tables are populated and paginated automatically.
[bookmark: _Toc418237289][bookmark: _Toc418239855][bookmark: _Toc418240936][bookmark: _Toc418244572][bookmark: _Toc418251143][bookmark: _Toc418251266][bookmark: _Toc418520282][bookmark: _Toc423441493]Citation Styles and Template Formatting
Authors follow citation style guides such as APA, MLA, or Chicago/Turabian to format work for submission to journals or publishers; the format is often changed for final publication. 
You must follow the content-related requirements specified by the citation style you are using: for example, how you will format the in-text citations and bibliography.
[bookmark: _GoBack]The Library’s thesis template is designed to prepare your work for publication as an SFU thesis. The template is meant to accommodate documents from a variety of disciplines, and does not conform to any single citation style. 
[bookmark: _Toc379398043][bookmark: _Toc418520283][bookmark: _Toc303784799][bookmark: _Toc305676199]SFU’s publication style supersedes the citation style for certain format-related elements: for example, font, line spacing, or margin size. These differences between citation styles and the template formatting are acceptable for SFU Library submission.
[bookmark: _Toc423441494]How to Begin
[bookmark: _Toc418520284][bookmark: _Toc423441495][bookmark: _Toc379398044]Numbered and Unnumbered Templates
There are two template files available from the Library, with numbered headings (as seen in this document) or unnumbered headings. Consult your senior supervisor if you are unsure which option to use. The majority of science and social science theses use numbered headings. Unnumbered headings are typically used in the arts and humanities.
[bookmark: _Toc418237293][bookmark: _Toc418239859][bookmark: _Toc418240940][bookmark: _Toc418244576][bookmark: _Toc418251147][bookmark: _Toc418251270][bookmark: _Toc418520285][bookmark: _Toc423441496]Downloading a Thesis Template File
Visit http://www.lib.sfu.ca/help/writing/thesis/templates to download the latest version of a thesis template. The template files have been tested on Windows and Apple Word releases from 2008 through 2013. If you require an older format .doc file to work with, please contact the Theses Office.
[bookmark: _Ref395794405][bookmark: _Ref395794407][bookmark: _Ref395796398][bookmark: _Ref395796401]Some changes to Word’s default viewing options and autocorrect settings are recommended.  The settings instructions are available on the templates webpage. 
[bookmark: _Toc418520286][bookmark: _Toc423441497]Using Show/Hide ¶
Show/Hide ¶ allows you to view hidden/non-printing symbols, including spaces, tabs, breaks, and paragraph marks. The Show/Hide ¶ button is found on the Home tab in current versions of Word. 
[bookmark: _Toc423441589]Table 1.1.	Non-printing (Hidden) Symbols 
	·
	space

	→
	tab

	
	line break/soft return 
hold [shift] and press [enter] to insert a line break/soft return within a paragraph

	¶
	paragraph marker 
shows the end of a paragraph

	▪
	indicates that a specific type of paragraph formatting has been applied
for example: a header, table caption, or reference entry

	[image: ]
	page break
use Insert > Page Break (Windows), Insert > Break > Page Break (Mac) to start a new page when required

	[image: ]
	section break
used for advanced document setup; see 1.2.4 and 1.5.2 for details


[bookmark: _Toc418237296][bookmark: _Toc418239862][bookmark: _Toc418240943][bookmark: _Toc418244579][bookmark: _Toc418251150][bookmark: _Toc418251273][bookmark: _Toc418520287][bookmark: _Toc423441498][bookmark: _Toc303784800][bookmark: _Toc305676200][bookmark: _Toc379398045]Organization of the Thesis Template
The thesis template is designed for all departments and disciplines at SFU, and contains several preformatted pages. You will need to remove the pages that do not apply to your document.
SFU theses must contain the following three sections, with pages appearing in the following order:
1. Title page (no page number; one page only; required)
2. Preliminary pages (Roman pagination, beginning with page ii)
Approval page (page ii; unsigned; required)
Ethics Statement (page iii; if applicable; see 5.1. Ethics Approval for Human or Animal Research)
Abstract and keywords (one page only; required)
Dedication (optional); Quotation (optional); Acknowledgements (optional)
Table of Contents (required)
Lists of Tables (if applicable); List of Figures (if applicable)
List of Acronyms (optional); Glossary (optional)
Preface/Executive Summary/Introductory Image (optional)
3. Main body; References; Appendix(es) (Arabic pagination, beginning with page 1)
Word uses section breaks to separate parts of a document. Avoid removing the existing section breaks – doing so will result in pagination errors. Use Show/Hide ¶ to see where the breaks are placed in the document to avoid accidental deletion. 
[bookmark: _Ref423419901][bookmark: _Ref423419927][bookmark: _Ref397078663][bookmark: _Ref397078665][bookmark: _Toc418520288][bookmark: _Toc423441499]About Word Styles
A style is a formatting preset that determines font, size, line spacing, and other attributes. Any formatting done from the Font or Paragraph menus can be saved as a style. Styles always apply to an entire paragraph.
Styles ensure that formatting is consistent throughout your document. They allow you to make quick changes to the whole document instead of formatting paragraphs manually. Styles can hold character and paragraph formatting. Character formatting refers to font, font size, bold or italic type, and so on. Paragraph formatting refers to indentation, line spacing, tab settings, and page breaks. 
Styles also control the space between paragraphs and the layout of text and objects. For example, a figure may consist of three paragraphs: the figure, the caption, and a note. These paragraphs may get separated and break across pages. The appropriate styles will keep the figure, caption, and note on the same page.
[bookmark: _Toc379398059][bookmark: _Ref396909731][bookmark: _Ref396909735][bookmark: _Toc418520289][bookmark: _Toc423441500][bookmark: _Toc379398058]How to See All the Styles
In Word 2011/2013, the Home tab contains a Styles ribbon view. Click the icon in the bottom right corner of this ribbon to open the Styles pane.
To view all styles included in the thesis template:
Windows: Click Options… at the lower-right of the style pane. Select All styles and Alphabetical to sort the list (Figure 1.1). 
Mac: Select “All Styles” from the List option at the bottom of the Styles pane.
If you have an older release of Word with different menus, please feel free to contact the Theses Office for help.
[bookmark: _Toc418520290][bookmark: _Toc423441501]Description of the Template Styles
The thesis template contains both SFU Library-designed styles and embedded Microsoft styles. A list of all SFU Library-designed styles found in the template is found in the Thesis Template Styles Reference List on the Thesis website.
[bookmark: _Toc423441502]What is Normal?
Normal is the default style in a Word document, and is the foundation for almost all other styles in the template. Normal is used for all regular paragraphs in the main body of the thesis. 
Normal is set for 1.5 line spacing, with a slight extra space between paragraphs. It’s not necessary to add blank lines between paragraphs or sections.
[bookmark: _Toc418520292]

[bookmark: _Toc423441503]Heading styles
Heading styles are used to title the sections and subsections of the document. You must use heading styles for the Table of Contents to populate automatically. Headings must be used in hierarchical order where appropriate:
	Chapter 1. Heading 1
1.1. Heading 2 (numbered template); Heading 2 (unnumbered template)
1.1.1. Heading 3 (numbered template); Heading 3 (unnumbered template)
Heading 4; Heading 5; Heading 6; and so on…
Also in the Headings style section:
Heading styles for the Preliminary pages
Heading 1_Preliminary
Heading 1_Invisible
Heading 1_Lists_noPageBreakBefore
Heading styles for References
Heading 1_References; Heading 2_References; Heading 3_References
Heading styles for Appendix(es) 
Heading 1_Appendix(es); Heading 2_Appendix(es); Heading 3_Appendix(es); Heading 4_Appendix(es)
[bookmark: _Toc418520293][bookmark: _Toc423441504]Custom template styles
Besides the Normal and Heading styles, the thesis template includes custom styles for specific elements. These have been numbered in sections: see Tables 1.2, 1.3., 1.4. 
[bookmark: _Ref395692106][bookmark: _Ref396211536][bookmark: _Toc309062740][bookmark: _Toc365894540][bookmark: _Ref395692102][bookmark: _Ref396211532]The list of styles is intended to provide options for all areas of study. For specific questions about which styles to use, you can consult your academic citation style guide, your supervisor, or the Theses Office, as required. 


[bookmark: _Toc423441590]Table 1.2	Sections and Corresponding Styles Used to Format Your Thesis
	Section of Document
	Specifically used for:
	Styles begin with

	Title Page
	
	1_TP_

	Preliminary Pages
(pages after Title Page and before the start of the body at p. 1, Chapter 1 / Introduction)
	Approval page
	2_Approv_

	
	Abstract & keywords
	2_Abstract_

	
	Dedication
	2_Dedication

	
	Acknowledgements 
	2_Acknow_

	
	Acronyms
	2_ListOfAcronyms/Glossary/etc._Normal

	Body of the document
(everything from p. 1, Chapter 1 / Introduction, onward to the beginning of the References
	Chapter Headings
	Chapter 1. Heading 1

	
	Sub-headings, 
Sub-sub headings, etc.
	1.1. Heading 2/Heading 2, 1.1.1. Heading 3/Heading 3, Heading 4, etc.
(up to 5 levels generate into the ToC)

	
	Regular paragraphs
	Normal

	
	Block quotes, lists, bullets, epigraphs, verse.
Non-indented paragraphs
	3_Body_

	References
	
	5_References_

	Appendix(es)
	
	6_Append_


Note. The 3_Body_ styles can also be used in the Appendices.
[bookmark: _Ref395693768][bookmark: _Toc309062741][bookmark: _Toc365894541][bookmark: _Toc423441591]Table 1.3.	Styles for Objects, such as tables, figures, and equations
	Specifically for the:
	Styles beginning with:

	Captions (Titles): 
Tables, Figures, Images, Photos, Poems, Schemes, etc.
	7_Captions…

	Content
	

	Tables and notes
	7_Table…

	Figures and notes
	7_Figure…

	Equations
	7_Equation_


[bookmark: _Toc309062742][bookmark: _Toc365894542]Note. The 7_ styles can also be used in the Appendices.
[bookmark: _Toc423441592]Table 1.4.	Special Styles Available
	Styles created specifically for:
	Styles beginning with:

	Heading 1 for  Extended Essays titles or very large theses with Parts
	8_

	Scripts, dialogue, stage directions, etc. 
(e.g. for Humanities, Contemporary Arts, languages and literature)
	9_


Note. Students with other custom style requirements are welcome to contact the Theses Office for help.
[bookmark: _Toc379398061][bookmark: _Toc418520294][bookmark: _Toc423441505]How to Apply a Style
A style applies to an entire paragraph: place the cursor anywhere in the paragraph before clicking a style on the style pane to apply it. 
You can also select multiple paragraphs or pages and apply a style to the entire selected area.
[bookmark: _Toc418520295][bookmark: _Toc423441506]How to See Which Style is Currently Applied
[bookmark: _Toc418520296]Windows: To find the style currently applied to a paragraph, place the cursor in the paragraph and scroll through the Style Pane to find the highlighted style. 
[bookmark: _Toc418520297]Mac: The current style is always displayed in a window at the top of the Style Pane.
You may need to reapply an already-selected style if the paragraph is not displaying properly.
[bookmark: _Toc379398125][bookmark: _Toc418520298][bookmark: _Toc423441507][bookmark: _Toc379398049]The Navigation Pane / Document Map
Viewing the Navigation Pane or Document Map can assist in viewing the overall structure, troubleshooting headings, and navigating throughout the document. To view the Navigation Pane or Document Map:
(Windows): In the View menu, select the checkbox beside Navigation Pane 
(Mac) Select View  Document Map 
[bookmark: _Toc418520299][bookmark: _Toc423441508]Important Reminders
[bookmark: _Toc418520300][bookmark: _Toc423441509]Requirements and Format
Please refer to the Requirements & Format web pages (http://www.lib.sfu.ca/help/writing/thesis/format) when completing your document. These web pages will guide you on overall formatting guidelines.,
[bookmark: _Toc305676203][bookmark: _Toc379398051][bookmark: _Ref395796415][bookmark: _Ref395796417][bookmark: _Toc418520301][bookmark: _Toc423441510]Adding Section Breaks
Adding section breaks to the document is necessary:
to insert a landscape or bifold page
to restart footnote numbers at “1” in each new chapter, if required by your citation style
After adding a section break, please ensure that margins do not change and that page numbers are continuous before and after the breaks.
[bookmark: _Ref395695633][bookmark: _Toc418520302][bookmark: _Toc423441511][bookmark: _Toc379398053]Manual Formatting
Styles save time and effort over manual formatting. Manual formatting is appropriate for unique instances, for example, if one paragraph contains special content with a different format from the rest of the document. To make global changes to the document such as a different font or line spacing, it’s more efficient to modify styles than to make changes to individual parts or paragraphs (see Chapter 4. Modifying Styles).
[bookmark: _Toc418251162][bookmark: _Toc418251289][bookmark: _Toc379398055][bookmark: _Toc418520303][bookmark: _Toc423441512]Redacting Personal Information
Signatures, personal phone numbers, or personal email addresses must be redacted from your document. This means that the text must be fully removed, and cannot be copied and pasted out of the document. 
Using Word to highlight text in black is not acceptable: the text is still present and can be copied
Use underscores, ellipses or other characters [xxx] to indicate where text has been redacted
You can also use the security features in Acrobat Pro to redact text from your final pdf
If you need help redacting personal information from your document, please contact the Theses Office.
[bookmark: _Toc379398062][bookmark: _Ref397086679][bookmark: _Ref397086680][bookmark: _Toc418520304][bookmark: _Toc423441513]

Formatting Your Thesis
[bookmark: _Toc418520305][bookmark: _Toc423441514]Using the Template
You can either begin writing in the template file directly, or you can transfer text from another file or files. You can also do a combination of writing in the template and copying and pasting from other documents.
[bookmark: _Toc418251168][bookmark: _Toc418251295][bookmark: _Toc379398046][bookmark: _Toc418520306][bookmark: _Toc423441515]Composing Directly in the Template
Begin at the placeholder paragraph after the Chapter 1… heading, and replace it with your own text. When you need to change the formatting from a regular (Normal) paragraph to a new chapter or type of element, apply styles as appropriate.
[bookmark: _Toc379398047][bookmark: _Toc418520307][bookmark: _Toc423441516]Transferring Text from Another File
1. 	Select and copy the text in the source file that you wish to transfer.
2. 	Paste into your thesis file after the Chapter 1… heading.
Apply the Normal style to the transferred text immediately. You can select all the pasted text and apply Normal to it, or work through the text section by section, applying Normal to regular paragraphs and other styles for headings, quotes, and other elements as they appear.
Rarely, not everything in a paragraph will change to the selected style. (This can happen when a draft contains text pasted from different applications, e.g., Apple Pages or a web browser.) You may need to apply a style more than once, or select the paragraph to reapply the style.
[bookmark: _Toc418520308][bookmark: _Toc418251171][bookmark: _Toc418251298][bookmark: _Toc418251172][bookmark: _Toc418251299][bookmark: _Toc418251173][bookmark: _Toc418251300][bookmark: _Toc418251174][bookmark: _Toc418251301][bookmark: _Toc418251175][bookmark: _Toc418251302][bookmark: _Toc418251176][bookmark: _Toc418251303][bookmark: _Toc418251177][bookmark: _Toc418251304][bookmark: _Toc418251178][bookmark: _Toc418251305][bookmark: _Toc418251179][bookmark: _Toc418251306][bookmark: _Toc418251180][bookmark: _Toc418251307][bookmark: _Toc418251181][bookmark: _Toc418251308][bookmark: _Toc418251182][bookmark: _Toc418251309][bookmark: _Toc379398066][bookmark: _Toc418520309][bookmark: _Toc423441517]The Thesis Body
[bookmark: _Toc379398067][bookmark: _Ref396481403][bookmark: _Ref396481405][bookmark: _Ref396999065][bookmark: _Ref396999068][bookmark: _Toc418520310][bookmark: _Toc423441518]Heading Styles
Heading styles are used to designate sections and subsections of a document. The template’s heading styles also automatically populate the Table of Contents. 
[bookmark: _Ref395872114][bookmark: _Toc423441593][bookmark: _Toc309062743][bookmark: _Toc365894544][bookmark: _Toc367054411]Table 2.1.	Levels of Heading Styles 
	Headings and  Sub-headings
	Style to Apply

	Chapter Headings
	Chapter 1. Heading 1

	Sub-headings
	1.1. Heading 2 
[numbered template]
Heading 2 
[unnumbered template]

	Sub-sub-headings
	1.1.1. Heading 3 
[numbered template]
Heading 3 
[unnumbered template]

	Sub-sub-sub-headings
	Heading 4

	Sub-sub-sub-sub-headings
	Heading 5


The template includes 9 heading levels. Consult your citation style guide for specific directions: for example, APA uses a maximum of 5 heading levels. Only up to 5 heading levels appear in the Table of Contents.
Chapter headings are auto-numbered; please do not number chapters manually. To display long chapter titles neatly, start the title on a new line after the chapter number by adding a line break [shift-enter].
[bookmark: _Toc418520311][bookmark: _Toc423441519][bookmark: _Toc303784803][bookmark: _Toc305676207][bookmark: _Toc379398068]Subsections without true headings
You may want to designate a section within a chapter or subsection without a heading that appears in the Table of Contents. You can use the 3_Body_FlushLeft_Bold or 3_Body_FlushLeft_Italic styles for this purpose. 
[bookmark: _Toc418520312][bookmark: _Toc423441520]Modifying heading styles
To change the appearance of heading styles, please see Chapter 4. Modifying Styles, or make an appointment with the Theses Office.
[bookmark: _Toc418520313][bookmark: _Toc423441521][bookmark: _Toc418520314]Quotations, Lists, and Poems 
There are various 3_Body_Quote… styles in the template for different uses. These styles are paired for single-paragraph quotes or multiple paragraphs, as indicated in the style name.
For example, a single block quote with citation would use the 3_Body_Quote_SingleOrLast style. This style changes the indents, line spacing, and vertical alignment of the quote paragraph.
3_Body..._MultipleParas styles should be applied to all paragraph elements in a series, except for the last one in a list. 3_Body…_SingleOrLast styles should be applied to paragraphs that are either only one paragraph (single), or the last one within a series.
The same pairing of single/multiple paragraph styles is also used for lists, interview quotes, verse, and so on. Using the appropriate single/multiple version will ensure that elements within a series stay close together, and will keep the spacing between paragraphs and quotes consistent.
[bookmark: _Toc418520315][bookmark: _Toc423441522]Quotations
Important:
Consult your citation style guide, supervisor, or liaison librarian for assistance in correct citation and quotation usage. 
[bookmark: _Toc303784804][bookmark: _Toc305676208][bookmark: _Toc379398069][bookmark: _Toc418520316][bookmark: _Toc423441523]From publications
Quotations within paragraphs “have quotation marks around them but, when there is a quote within the quotation, ‘the original quotation marks are changed to single quotes’” (Wolfe 2011). Block quotes should be used for quotations of 40 words or more.
This is an example of a 3-paragraph block quote. 3_Body_Quote_MultipleParas is applied to the first two paragraphs, and 3_Body_Quote_SingleOrLast is applied to the last paragraph. 
The text before a block quote ends with either a period or a colon. Do not put quotation marks around a block quote. 
Punctuation at the end of a block quote should come directly after the quote, followed by the citation or footnote. As seen in this example, the period is not placed after the citation because the citation is not a part of the quote. (Einstein, 2015)
To continue a paragraph after a block quote, apply the 3_Body_FlushLeft style, as seen in this paragraph.
[bookmark: _Toc303784805][bookmark: _Toc305676209][bookmark: _Toc379398070][bookmark: _Ref396912020][bookmark: _Toc418520317][bookmark: _Toc423441524]Participant quotations
Some citation styles require interviewee / participant quotes to appear differently from the main body text. Two methods of displaying such quotations are included in the thesis template:
As with other 3_Body styles, the 3_Body_QuoteSubject_MultipleParas style is applied to all paragraphs in a series with the exception of the last paragraph. (Subject 17)
3_Body_QuoteSubject_SingleOrLast is applied to the last in of a series of block quote paragraphs, or when a participant’s quote paragraph appears on its own. (Participant X)
A style with hanging indents is also included, for interview-style quotes: 
Joanie: 	You can start by applying the 3_Body_QuoteSubject_HangingMultipleParas style to the paragraph, typing the participant’s name with a colon followed by a [Tab], then the participant’s statement. Press [Enter] at the end of the paragraph, and continue typing a rest of the series in the same way (Name, Colon, [Tab], Statement, [Enter]).
Interviewee: When the name is long, use a space rather than a [Tab] after the colon, as in this example. 
Joanie:	For the last paragraph, apply the 3_Body_QuoteSubject_HangingSingleOrLast style. Or you may type them all, then apply the styles as appropriate. 
Check the citation guide you are using for the details of how participant quotes should be formatted.
[bookmark: _Toc418520318][bookmark: _Toc379398071][bookmark: _Toc423441525]Epigrams
The template includes an italic style for epigrams or introductory quotes: 
We recommend that you consult your style guide on whether the parenthetical citation should follow the text directly or be right-aligned with a [Tab], as in this example. 	(Derrida, Of Epigrammatology, 1987)
[bookmark: _Toc418520319][bookmark: _Toc423441526][bookmark: _Toc303784806][bookmark: _Toc305676210]Bulleted lists
Apply the 3_Body_Bullet_MultipleParas style to all the bullets, then the 3_Body_Bullet_SingleOrLast style to the last one in a series.
When bulleted paragraphs are desired;
Apply the 3_Body_Bullet_MultipleParas style to all paragraphs to be bulleted and;
For the last paragraph only, apply the 3_Body_Bullet_SingleOrLast style.
For second-level bullets or sub-bullets within bulleted lists, you can use the 3_Body_Bullet_Level2_MultipleParas and 3_Body_Bullet_Level2_SingleOrLast styles as appropriate. 
[bookmark: _Toc379398073][bookmark: _Toc418520320][bookmark: _Toc423441527][bookmark: _Toc303784815][bookmark: _Toc305676218]Numbered or lettered lists
We recommend manually numbering/lettering lists in the document. 
1. 	When numbered paragraphs are desired;
2. 	Rather than using Word’s auto-numbering;
3. 	Type the number/letter, [punctuation], [Tab], and the text;
4. 	Apply the 3_Body_List-Manual_MultipleParas style to all numbered styles.
5. 	For the last numbered paragraph only, apply the 3_Body_List-Manual_SingleOrLast style.
[bookmark: _Toc379398084][bookmark: _Toc418520321][bookmark: _Toc423441528]Poems
Verses of a poem are formatted using the 3_Body_Verse_MultipleParas and 3_Body_Verse_SingleOrLast styles. Each line of a verse is separated with a line break/soft return (press [Shift]+[Enter]). 
Poem captions can be inserted to generate a List of Poems in the preliminary pages; see Adding new caption labels and 3.2.2. Adding Other Lists to the Preliminary Pages for more information.
Poem 2.1.	Daffodils – Karen Eliot (2012)
i o be gazed dances tossing trees
in they a of and cloud beneath
in wandered not out saw did a
but saw upon eye my and wealth for; 
all the that way on a the
crowd hills inward bay sparkling in lonely
line i had dancing brought or a
in but show and never heads
To display the poem with a larger left indent, you can use the 3_Body_VerseIndented_MultipleParas and 3_Body_VerseIndented_SingleOrLast styles.
Poem 2.2.	Thesis-Writing Haiku – Anonymous (n.d.) 
Writing a thesis -
many things to remember
You can ask for help!
[bookmark: _Toc418520322][bookmark: _Toc423441529]Stories, Narratives, Journal Entries, other text
For stories, narratives, journal entries, etc., you can use the 3_Body_FlushLeft_Italic style. Story captions can be inserted to generate a List of Stories in the preliminary pages; see Adding new caption labels and 3.2.2. Adding Other Lists to the Preliminary Pages for more information. 
[bookmark: _Toc418251196][bookmark: _Toc418251323][bookmark: _Toc418251197][bookmark: _Toc418251324][bookmark: _Toc418251198][bookmark: _Toc418251325][bookmark: _Toc418251199][bookmark: _Toc418251326][bookmark: _Toc418251200][bookmark: _Toc418251327][bookmark: _Toc418251201][bookmark: _Toc418251328][bookmark: _Toc418520323][bookmark: _Toc423441530]Using Tables, Figures, and Other Objects
Tables and figures are very commonly used; other objects such as schemes, equations, photos, illustrations, maps, or poems may also be included.
Tables are text-based – they contain text and data, and are styled differently than figures. 
A figure may be a photo or image, or it may be a graphical combination of text and data.
For other text-based objects, follow the instructions for Tables. For other graphic objects, follow the instructions for Figures. 
[bookmark: _Toc423441531]Elements of Tables, Figures, and Objects
There are always two, and often three, elements required to format an object:
1. 	The object itself: the table, image file, or text
2. 	Caption: the title or short description of the object
3. 	Note (optional): for additional information, typically the source of the image or data, or descriptive details which are too long for the caption
The template includes versions of styles for each of these elements.
Important: 
The maximum allowed width for objects is 6 inches on a portrait page or 9 inches on a landscape page. Objects must fit inside the text margins of the page.
[bookmark: _Toc418251203][bookmark: _Toc418251330][bookmark: _Toc418520324][bookmark: _Ref423349124][bookmark: _Toc423441532]Captions and Notes
In most citation styles, table captions appear above tables and figure captions appear below figures: check the style guide you are using for directions. Placement of figure and table captions should be consistent throughout the document.
[bookmark: _Ref396397680][bookmark: _Toc418520325][bookmark: _Toc423441533]Captions
Creating captions for tables and figures is a two-step process:
1. Insert the caption using the (Windows) References  Insert Caption or (Mac) Insert  Caption menu. 
2. Apply a template caption style.
This will produce automatically-numbered captions that populate the List of Tables and List of Figures in the preliminary pages. Typing the caption labels and numbers will not create automatic lists. 
[image: ]
[bookmark: _Ref396215951][bookmark: _Toc423441597]Figure 2.1.	The Caption dialogue box (Windows)
To insert a caption:
1.	Place your cursor in a new paragraph where you’d like to insert the caption.
2.	Enter the (Windows) References  Insert Caption or (Mac) Insert  Caption menu to view the Caption dialogue box (see Figure 2.1). 
3.	Select the appropriate Label (Table, Figure, etc.)
4.	Select a numbering format: Click Numbering… in the Caption dialogue box to add/remove chapter numbers (Table 1.1, 1.2, 1.3 … 2.1, 2.2, 2.3 …). 
5..	Click OK.The caption will appear with an auto-numbered label. 
6.	After inserting each caption label and number, type a [period], and a [Tab]. This will create a flush left margin for the caption and on the preliminary page Lists.
7.	Type the title of your caption. All text in the caption paragraph will link to the respective preliminary page List.
8.	Apply the appropriate style to the caption:
7_Captions_aboveTablesFigures 
7_Captions_belowFigures_noNoteAfter
[bookmark: _Toc379398093]7_Captions_belowFigures_withNoteAfter
[bookmark: _Ref396480997][bookmark: _Toc418520326][bookmark: _Toc423441534]Adding new caption labels 
To insert a label for a new class of object (e.g., equations, schemes, etc.):
1. 	Enter the (Windows) References  Insert Caption or (Mac) Insert  Caption menu to view the Caption dialogue box (see Figure 2.1). 
2. 	Click New Label and type in the label required, such as Image, Scheme, Poem, Photo, Story, etc. (see Figure 2.2). Click OK.
3. 	Follow the caption instructions as directed in Captions.
[image: ]
[bookmark: _Ref396395676][bookmark: _Toc379225945][bookmark: _Toc423441598]Figure 2.2.	Creating a New Caption Label
[bookmark: _Toc303784813][bookmark: _Toc305676217][bookmark: _Toc379398095][bookmark: _Toc418520327][bookmark: _Toc423441535]Re-numbering captions after adding, editing, or moving sections
If you need to add, remove, or move captions in your document, the caption numbers may not update automatically. To correct the numbering:
1. 	Select all the body text containing the captions.
2. 	[Windows] Press [F9] OR right-click anywhere in the selection and choose Update Field.
[Mac] Control-click on the selection and choose Update Field.
3. 	Update preliminary page lists (see 3.2. Lists Populated by Auto-numbered Captions for information about updating lists).
[bookmark: _Toc418520328][bookmark: _Toc423441536]Notes
Additional information about an object, such as descriptive or source information, can be added as a note. This is a separate paragraph that will not appear in the preliminary page lists. 
[bookmark: _Toc379398076][bookmark: _Toc418520329][bookmark: _Toc423441537]Tables
7_TableRow_Normal is the default style for table data; there are several other table styles for displaying data and headers available. Place the cursor in different cells and look in the style pane to see the styles used in Table 2.2 and Table 2.3.
[bookmark: _Ref396400148][bookmark: _Toc423441594]Table 2.2.	Sample table
	[bookmark: _Ref396399456][bookmark: _Toc309062746][bookmark: _Toc365894547][bookmark: _Toc367054414][bookmark: _Ref396399442]Participants
	Institution:
C=College;
UI=Teaching University
RU= Research University
	Gender
(M / F)
	Experience in teaching and/or instructional development (yes)
	Length of Interview (minutes)

	1
	C
	M
	27
	49

	2
	UI
	F
	22
	51

	3
	RU
	M
	18
	55

	4
	RU
	M
	06
	52

	8
	UI
	F
	19
	61

	9
	UI
	F
	20
	67

	10
	C
	F
	17
	43


Note. 	Adapted from Women in Transition: Exploring Women's Movement through the Neutral Zone, by B. Sweeney, in press, Vancouver, British Columbia, Canada: Adler School of Professional Psychology. Copyright 2011 by B. Sweeney. Adapted with permission.
[bookmark: _Ref396464545][bookmark: _Toc423441595]Table 2.3.	A Sample Table: Participation Rates
	
	Helping
Critical Incidents
(n=104)
	
	Hindering 
Critical Incidents
(n=70)
	
	Wish List Items
(n=49)

	
	Participants
(n=7)
	
	Incident
	
	Participants
(n=7)
	
	Incident
	
	Participants
(n=7)
	
	Incident

	Category
	n
	%
	
	n
	
	n
	%
	
	n
	
	n
	%
	
	n

	Support from Family/Friends
	7
	100
	
	20
	
	6
	86
	
	15
	
	5
	71
	
	10

	Personal Resources/
Coping Skills
	7
	100
	
	34
	
	6
	86
	
	19
	
	2
	29
	
	6

	Lack of Clarity
	0
	0
	
	0
	
	2
	43
	
	3
	
	1
	14
	
	1

	Education Regarding Transition Process 
	1
	14
	
	1
	
	1
	14
	
	1
	
	2
	29
	
	3


Note. 	Adapted from Women in Transition: Exploring Women's Movement through the Neutral Zone, by B. Sweeney, in press, Vancouver, British Columbia, Canada: Adler School of Professional Psychology. Copyright 2011 by B. Sweeney. Adapted with permission.
You can create tables in Word, or transfer a table from another Word or Excel document. When copying in, we suggest applying 7_TableRow_Normal to the entire table as a first step before fine-tuning the appearance.
[bookmark: _Toc418520330][bookmark: _Toc423441538]Tables with captions above
[bookmark: _Toc379398078]Insert a paragraph where the table caption will be:
1. 	Insert a Table caption as directed in Captions. The caption should read Table #.#[Tab]Title of Table.
2.	Apply the 7_Captions_aboveTablesFigures style to the caption’s paragraph.
[bookmark: _Toc379398079]The table should be in a new paragraph below the caption:
1. 	Select the entire table, and apply the 7_TableRow_Normal style. 
2. 	From this point, you can apply additional styles to the table cells, rows, and columns.
3.	Consult your style guide to see how cell borders should be formatted: for example, APA recommends omitting vertical borders between columns.
[bookmark: _Toc379398080]A table note could be placed in another paragraph below the table:
1.	Insert note paragraph below the table, and apply the 7_TableNote_FlushLeft or 7_TableNote_HangingIndent style. 
If you want to insert multiple notes on new lines within the note paragraph, use a line break/soft return (press [Shift]+[Enter]).
[bookmark: _Toc379398083][bookmark: _Toc418520331][bookmark: _Toc423441539]Editing table properties
The following settings are recommended for tables, where applicable:
Select the table, and in the Layout tab of the Table Tools menu, select Properties.
[image: ]
[bookmark: _Ref396472297][bookmark: _Ref396400612][bookmark: _Toc423441599]Figure 2.3.	The Table Properties dialogue box (Windows)
On the Table tab:
Check Preferred width: set a maximum of 6” on a portrait page or 9” on a landscape page
Set Text wrapping to None
If the table is long and breaks over one page:
In the Row tab, check Repeat as header row at the top of each page. Click OK. This will place a repeating header at the top of each page.
For large tables, the font size can be reduced to Arial Narrow 10pt.
[bookmark: _Toc379398081][bookmark: _Toc418520332][bookmark: _Toc423441540][bookmark: _Toc379398086]Footnotes for tables
[bookmark: _Ref397508785][bookmark: _Toc309062745][bookmark: _Toc365894546][bookmark: _Toc367054413][bookmark: _Ref396399196]Footnotes for tables should be created manually.. Use the 7_TableNote_FlushLeft style to format the paragraph. Use a superscripted letter (a, b, etc.) or asterisks (*, **, and/or ***) to begin the note. If a table note is required as well, the footnotes appear first (see Table 2.4). 


[bookmark: _Toc423441596]Table 2.4.	A Sample Table: With Fictitious Categories, Variables, and Data
	Subject Areas
	PSYC 100a
	
	PSYC 102b
	PSYC 201

	
	M
	SD
	
	N
	
	M
	SD
	
	N
	

	Behavioural
	1.456(78)
	7.890(20)
	
	6.890(50)
	
	.890(20)
	7.543(69)
	
	.89(50)
	7.543(69)

	Theory & Methods
	7.53(69)
	6.890(50)
	
	1.456(78)
	
	7.543(69)
	6.890(50)
	
	1.456(78)
	6.890(50)

	Social & Developmental 
	6.890(50)
	7.54(69)
	
	7.890(20)
	
	6.890(50)
	1.456(78)
	
	7.890(20)
	7.890(20)


a PSYC 100 must be taken first; 
b PSYC 102 is taken after credit is earned for PSYC 100. 
Note. Adapted from Smith, 2010.
[bookmark: _Toc418520333][bookmark: _Toc423441541]Figures
Instructions for figures also apply to any object inserted from an image file. Figures should be inserted as flattened image files (JPG, PNG, or TIF), at a size equivalent to 300dpi resolution. For example, an image 6 inches wide should be 1800 pixels wide to produce an equivalent resolution of 300pdi:
6 inches X 300dpi = 1800px
Figures with multiple objects, such as flowcharts, should be created outside Word in an image editor (Photoshop, Illustrator, Powerpoint, etc) and inserted as flat images. 
Text wrapping should be set to In Line with Text (no wrapping). 
[bookmark: _Toc418520334][bookmark: _Toc423441542]Figures with captions below
Insert a paragraph where the figure will be:
1.	Place the figure from the Insert menu or by pasting. 
2. 	Select the figure, and apply 7_Figure_withNoteOrCaptionAfter to correct its position on the page.


The caption should be in a new paragraph below the figure:
1. 	Insert a Figure caption as directed in Captions. The caption should read: Figure #.#[Tab]Title of Figure.
2. 	Based on whether there is a note below the caption, apply the 7_Captions_belowFigures_noNoteAfter or 7_Captions_belowFigures_withNoteAfter style to the caption paragraph.
[image: ]
[bookmark: _Toc423441600]Figure 2.4.	Sample Figure followed by a Caption
A figure note can be placed in a paragraph below the figure caption:
1.	Insert a new paragraph for the note below the figure, and apply 7_FigureNote_FlushLeft or 7_FigureNote_HangingIndent. 
To insert multiple notes on new lines in the note paragraph, use a line break/soft return (press [Shift]+[Enter]).
[image: ]
[bookmark: _Toc423441601]Figure 2.5.	Sample Figure followed by a Caption and a Note
Note.	Echidna. By JKMelville (Own work) [CC BY-SA 3.0 (http://creativecommons.org/licenses/by-sa/3.0)], via Wikimedia Commons 
To include the figure caption and note in the same paragraph, apply 7_Captions_belowFigures_includesNote 
[bookmark: _Toc418520335][bookmark: _Toc423441543]Figures with captions above
Insert a paragraph where the figure caption will be:
1. 	Insert a Figure caption as directed in Captions. Your caption should read Figure #.#[Tab]Title of Figure.
2. 	Apply the 7_Captions_aboveTablesFigures style to the caption paragraph.
The figure should be in a new paragraph below the caption:
1.	Place the figure using the Insert menu or paste.
2. 	Based on whether there is a note below the figure, apply 7_Figure_noNoteOrCaptionAfter or 7_Figure_withNoteOrCaptionAfter style 
[bookmark: _Toc365894549][bookmark: _Toc379225944]A figure note can be placed in another paragraph below the figure:
1.	Insert a new paragraph below the figure for the note and apply 7_FigureNote_FlushLeft or 7_FigureNote_HangingIndent. 
To insert multiple notes on new lines within the note paragraph, use a line break/soft return (press [Shift]+[Enter]).
[bookmark: _Toc423441602]Figure 2.6.	Sample with Caption followed by the Figure and a Note
[image: ]
[bookmark: _Toc379398089]Source:	Random graphs generated in Microsoft Excel (Eliot, 2015).
Note.	Remember to consult your style guide to check the proper placement of captions.
[bookmark: _Toc379398092][bookmark: _Toc418520336][bookmark: _Toc423441544][bookmark: _Toc367055762]Large figures
For large figures that are hard to fit on a single page, use the 7_Captions_belowFigures_noSpaceAfter or 7_FigureNote_noSpaceAfter styles for captioning (as applicable). These styles have minimal white space below the paragraph, which provides additional space for the figure. 
[bookmark: _Toc305676204][bookmark: _Toc379398054][bookmark: _Toc418520337][bookmark: _Toc423441545]Using tables to place multiple images in one figure
Use tables to create figures with more than one image. For example, to arrange three images in a row with one caption, create a 3X1 table and insert the images into each cell (see Figure 2.7). Remove cell borders and apply a figure style to each image.
	[image: ]
a
	[image: ]
b
	[image: ]
c


[bookmark: _Ref396473628][bookmark: _Toc379225937][bookmark: _Toc423441603]Figure 2.7.	Example of Three Images in a Table: One Row
Note.	Photo of “Portrait of Socrates” released into the public domain with no restrictions by Jastrow, 2007, via Wikimedia Commons.
[bookmark: _Toc379398094]You can also merge cells to create layouts within a table as desired. Please contact the Theses Office for any assistance in layout and arrangement of figures. 
[bookmark: _Toc418520338][bookmark: _Toc423441546]Equations
Two equation styles are included, 7_Equation_Centred and 7_Equation_LeftTabRight. The former centres the equation, while the latter indents the equation to align with the paragraphs. To add an equation number, insert the equation, press [Tab] to move the cursor to the right margin, and then type the equation number. 
X = Y + Z		(1)
If using the 7_Equation_Centred style, you must also press [Tab] before the equation: see the example below. 
	X = Y + Z	(1)
[bookmark: _Toc379398096][bookmark: _Toc418520339][bookmark: _Toc423441547]Copyright Permissions: Including Objects that Are Not Your Own Work
If your work includes reproductions of copyright-protected objects (figures, images, photos, maps, diagrams and so on), permission for use must be obtained from the copyright holder in most cases.
If you have previously published any of the content in your document, you must review the author agreement and determine if permission is required for you to republish this work in your thesis. 
Permission can be in the form of an email from the author or publisher, a Rightslink licence, a Creative Commons declaration on the source webpage, and so on. The library’s Copyright office can also provide a Fair Dealing opinion on the use of copyrighted material. All copyright permissions, including Fair Dealing memos, must be submitted as PDF files with your thesis. 
Important:
Please contact the Copyright at SFU Office and see http://copyright.sfu.ca for information on how to obtain copyright permissions. 
[bookmark: _Toc418520340]

[bookmark: _Toc423441548]References, Bibliography, Works Cited
References must appear after the body text and before the appendices. To add categories to the references, bibliography, or works cited, use the Heading 2_References and Heading 3_References styles on the title of each category.
It is also acceptable to create a References section for each chapter. In this case, use a regular Heading 2 and place the references at the end of the chapter.
With the exception of the American Antiquity style, references for all citation styles are formatted with a hanging indent (APA, Chicago, MLA, IEEE, etc.). Apply the 5_References_Normal style to these paragraphs. 
[bookmark: _Toc311054670][bookmark: _Toc379398148][bookmark: _Toc418520341][bookmark: _Toc423441549]American Antiquity
For American Antiquity citation style, place each author and each respective publication in a separate paragraph. 
Apply the 5_References_AmerAntiq_Authors to the paragraphs with the author(s) names in them.
Apply the 5_References_AmerAntiq_Years to subsequent paragraph(s) for the same authors (paragraphs that begin with the years). 
The author’s paragraph style is set to stay with the paragraphs that follow. Some examples of American Antiquity references utilizing these styles are as follows:  
Braidwood, Robert J.
1937	Mounds in the Plain of Antioch: An Archaeological Survey. The University of Chicago Press, Chicago.
Van Zeist, Willem and W. Waterbolk-van Rooijen
1985	The palaeobotany of Tell Bouqras, eastern Syria. Paléorient 11:131-147.
1992	Two interesting floral finds from third millennium B.C. Tell Hammam et-Turkman, northern Syria. Vegetation History and Archaeobotany 1:157-161.
Van Zeist, W. and H. Woldring
1980	Holocene Vegetation and Climate of Northwestern Syria. Palaeohistoria 22:111-125.
[bookmark: _Toc303784816][bookmark: _Toc305676219][bookmark: _Toc379398098][bookmark: _Toc418520342][bookmark: _Toc423441550]Appendices
Important:
Signatures, personal phone numbers, or personal email addresses must be redacted from your document. For more information, see 1.5.4. Redacting Personal Information
[bookmark: _Toc379398099][bookmark: _Toc418520343][bookmark: _Toc423441551]Appendix Headings
Appendices should be included in the thesis document after the references/bibliography/works cited. If you are unsure about whether content should be included in the body text or in an appendix, consult with your senior supervisor.
If there is more than one appendix, letter each accordingly (Appendix A, Appendix B …). Write the appendix headings in the same format as the chapter headings (see 2.2.1. Heading Styles). 
The Heading 1_Appendix(es) style is for the main headings of appendices, while Heading 2_Appendix(es) and Heading 3_Appendix(es) can be used for sub-headings within each appendix. 
[bookmark: _Toc379398100][bookmark: _Toc418520344][bookmark: _Toc423441552]Appendix Styles
The 6_Append_Normal style is the base style for appendices and uses indented and single-spaced paragraphs. You can use other 6_Append_ or 3_Body_ styles to format your appendix contents, as well as the 7_ object styles. 
Objects in appendices should not appear in preliminary page Lists; these are reserved for body objects. Thus, appendix caption labels and numbers should be typed in manually (e.g., Table A.1., Table A.2., etc.), and not inserted through the Insert  Caption menu. You will still need to apply the 7_Caption… styles used in the main body.
[bookmark: _Toc379398102][bookmark: _Toc418520345][bookmark: _Ref418606823][bookmark: _Ref418606831]

[bookmark: _Toc423441553]Including Other Documents within the Appendices
To include content from other documents in an appendix:
1.	Transfer the text and reformat using the template styles as necessary, or 
2.	Convert the documents into images (png, jpg, or pdf) and insert them into your document, one image per page.
[bookmark: _Toc423004903][bookmark: _Toc423344876][bookmark: _Toc423349803][bookmark: _Toc423349929][bookmark: _Toc423350055][bookmark: _Toc423350181][bookmark: _Toc423350307][bookmark: _Toc423004906][bookmark: _Toc423344879][bookmark: _Toc423349806][bookmark: _Toc423349932][bookmark: _Toc423350058][bookmark: _Toc423350184][bookmark: _Toc423350310][bookmark: _Toc423004908][bookmark: _Toc423344881][bookmark: _Toc423349808][bookmark: _Toc423349934][bookmark: _Toc423350060][bookmark: _Toc423350186][bookmark: _Toc423350312][bookmark: _Toc423004909][bookmark: _Toc423344882][bookmark: _Toc423349809][bookmark: _Toc423349935][bookmark: _Toc423350061][bookmark: _Toc423350187][bookmark: _Toc423350313][bookmark: _Toc423004910][bookmark: _Toc423344883][bookmark: _Toc423349810][bookmark: _Toc423349936][bookmark: _Toc423350062][bookmark: _Toc423350188][bookmark: _Toc423350314][bookmark: _Ref396984569][bookmark: _Ref396984572][bookmark: _Toc418520346][bookmark: _Toc423441554]Supplementary Material
Material that cannot be included in the final pdf can be uploaded as a supplementary file (data, audio, video, large images, and so on). Please refer to the Requirements & Format webpages (http://www.lib.sfu.ca/help/writing/thesis/format) for guidelines on file format and file size, or contact the Theses Office for more information.
If you are including supplementary material in your submission, you must also include an appendix in the thesis containing a description of the material, credits, and file name(s).



[bookmark: _Toc423441555]Landscape Pages and Sections
Including landscape pages in a document is relatively simple using Custom Margins in current versions of Word (2010 and up). This method creates required section breaks automatically. To ensure that formatting remains correct, follow these two steps:
1. 	Create the landscape section using the Custom Margins dialogue.
 Select the area where you want the landscape page(s) to appear.
Windows: Page Layout > Custom Margins > set Orientation to landscape, set Apply to: Selected Text.
Mac: Select text: Layout > Margins > Custom Margins > open Page Setup and change to landscape, set Apply to: Selected Text. 
2. 	Check the page numbering in the landscape section and set it to “Continue from the previous section.” Repeat on the first page after the landscape section. If this setting is not changed, every new section begins with a page number of 1.
Windows: Insert > Page Number > Format Page Numbers > Continue from Previous Section
On Mac: Insert > Page Numbers > Format > Continue from Previous Section
These steps can also be used to insert bifold (11X17 pages). For assistance formatting landscape pages or sections, please contact the Theses Office.
Important:
Using this method, the page number will appear at the bottom of a landscape page, as seen on this page. If the thesis is printed and bound, the number will be rotated. To move the page number back to its original position, follow the steps on the following page. This functionality is only available in Windows. . 
To rotate a landscape page number to the bottom of a printed page (Windows only):
1.	Double-click in the footer area of the landscape page and check “Different First Page” to remove the page number from the landscape page.
2.	Go to Insert > Page Number > Page Margins > Plain Number and select “Large, Left.” The page number will appear in a text box in the left margin. You may have to resize the text box to make the whole number visible.
3.	Highlight the number and apply the Footer style from the Styles pane.
4.	Go to Drawing Tools > Format > Text Direction and select “Rotate All Text 90”
The page number will display in the left margin with the correct orientation for binding, as seen on this page. For sections of multiple landscape pages, add a section break at the end of each page and repeat these steps on each page.
[bookmark: _Toc423441556]Landscape Pages and Sections – Important Note for Mac Users
When converting to PDF, some versions of Word for Mac split up the converted files into separate PDF files at each section break. You can use Adobe Acrobat Pro or Apple Preview to rejoin the PDFs into a single document.
[bookmark: _Toc423441557]Other Methods of Landscaping
It is also acceptable to convert a landscape table to an image, rotate and insert on a regular, portrait page. Note that text in these tables will not be searchable or editable. If your document uses landscape pages extensively, we recommend making an appointment with the Theses Office to check all formatting.


[bookmark: _Toc418520360][bookmark: _Toc423441558]

Table of Contents, List of Tables, List of Figures 
The SFU Library thesis template contains a Table of Contents (ToC), List of Tables (LoT), and List of Figures (LoF). 
The ToC is always required; the LoT and LoF are not required if there are no figures or tables in the document. Additional Lists (e.g., List of Schemes, List of Poems) can be added to the preliminary pages; see 3.2.2. Adding Other Lists to the Preliminary Pages, or contact the Theses Office for assistance. 
Updating the ToC and Lists populates them with the headings and captions from the document. Remember to update the ToC and Lists after making any changes. 
[bookmark: _Toc303784818][bookmark: _Toc305676221][bookmark: _Toc379398108][bookmark: _Ref396395235][bookmark: _Ref396395239][bookmark: _Toc418520363][bookmark: _Toc423441559]Table of Contents (ToC)
To update the Table of Contents:
1. 	(Windows) Click anywhere in the ToC so it becomes fully highlighted in gray. Right-click anywhere in the table to bring up a menu.
(Mac) Ctrl+click anywhere in the table to bring up a menu.
3. 	Select Update Field and, if an additional choice appears, select Update Entire Table.
4.	The ToC will populate with the document headings and their page numbers.
[bookmark: _Toc423441560]Troubleshooting the Table of Contents
Please note that there is a known issue with Word Tables of Contents: short headings do not always auto-format properly. 
In the template, the page number for “References” does not right-align after updating the table. Other short headings may display the same way, e.g. “Study 1.”
This must be corrected manually before submission to the library. To correct the issue:
· Place the cursor to the left of the page number, and press [Tab] until you see the page number align at the right margin. Mac users: place thecursor in the header text and use the arrow keys to move to the page number, then press [Tab]
OR
· Select the References entry line and apply the ToC_RefsOrBiblio style.
There are additional styling options you can apply to the Table of Contents after updating and before final PDF generation. For example, you can style appendix entries as follows:
1. 	Place the cursor before the “A” in the first Appendix and press [Enter] twice
This provides some additional space between the References entry and the Appendix(es).
2. 	Apply the ToC_Appendix(es) style to each of the main Appendix entries.
This is used to adjust the alignment of appendix titles.
[bookmark: _Toc423004917][bookmark: _Toc423344890][bookmark: _Toc423349817][bookmark: _Toc423349943][bookmark: _Toc423350069][bookmark: _Toc423350195][bookmark: _Toc423350321][bookmark: _Toc303784821][bookmark: _Toc305676224][bookmark: _Toc379398110][bookmark: _Ref396395304][bookmark: _Ref396395307][bookmark: _Ref396472783][bookmark: _Ref396472786][bookmark: _Toc418520364][bookmark: _Toc423441561]Lists Populated by Auto-numbered Captions
[bookmark: _Toc305676225][bookmark: _Toc379398111][bookmark: _Toc418520365][bookmark: _Toc423441562]List of Tables (LoT) and List of Figures (LoF)
Captions must be created using the Insert  Caption function to populate the List of Tables and List of Figures (see 2.5, Captions and Notes).
Once auto-numbered captions are inserted with the appropriate label(s), the Lists are updated as follows:
1. 	(Windows) Click anywhere in the List to highlight it in gray. Right-click anywhere in the highlighted area to bring up a menu.
(Mac) Ctrl+click in the List to bring up a menu.
3. 	Select Update Field and, if an additional choice appears, select Update Entire Table.
4.	The list will populate with the labels and captions in the document.
If the List doesn’t update, check that captions are inserted correctly with the correct label. 
[bookmark: _Ref396481205][bookmark: _Toc418520366][bookmark: _Toc423441563][bookmark: _Toc379398112][bookmark: _Ref396481020]Adding Other Lists to the Preliminary Pages
You may need to add other lists for schemes, equations, poems, and so on. Follow the directions in Adding new caption labels to create a new label that will populate a new preliminary page list.
To insert a new preliminary page list:
1. 	Start a new paragraph in the same section as the other Lists (if applicable), following the Table of Contents.
2. 	Type the heading (e.g., List of Schemes) and apply the Heading 1_Preliminary style to the new heading.
3. 	Press [Enter] to create a new paragraph below the new list heading.
· [Windows] select References  Insert Table of Figures.
· [Mac] Insert > Index and Tables > Table of Figures
4.	In the Table of Figures dialogue box (see Figure 3.1), select the appropriate Caption label from the General section. Press OK.
5.	The new list should appear.
[image: ]
[bookmark: _Ref396829906][bookmark: _Toc423441604]Figure 3.1.	The Insert Table of Figures dialogue box (Windows)
[bookmark: _Toc379398114][bookmark: _Toc418520367][bookmark: _Toc423441564]Placing More than One Preliminary Page List on a Page
If the preliminary page lists are short, they can all be placed on one page. Currently, the Heading1_Preliminary style is applied to all preliminary page headings, which automatically places a page break before the heading. To add another list to the same page, use the Heading 1_Lists_noPageBreakBefore style for the second list’s heading. 
[bookmark: _Toc379398113][bookmark: _Toc418520368][bookmark: _Toc423441565]Error Messages in the ToC or Lists.
If you see a message such as “Error Bookmark Not Defined,” update the Table of Contents or List and the error should disappear after updating. For help with updating the ToC or any lists, or for help with creating new lists, please contact the Theses Office.
[bookmark: _Toc303784822][bookmark: _Toc305676227][bookmark: _Toc379398115][bookmark: _Ref395698858][bookmark: _Ref395698860][bookmark: _Ref395872068][bookmark: _Ref395872071][bookmark: _Ref396395155][bookmark: _Ref396395159][bookmark: _Toc418520369][bookmark: _Toc423441566]

Modifying Styles
[bookmark: _Toc303784823][bookmark: _Toc305676228]If you want to make global changes to the thesis – such as changing the default font- it is preferable to modify styles rather than make manual running changes.
Modifying styles can have unintended effects. For example, most styles are based on the Normal style. Therefore, changing the Normal style’s font or paragraph formatting will have an effect on (almost) every other style. 
We recommend consulting the Theses Office before any major modifications to template styles. 
Important: 
Before changing fonts, etc., first be sure you are adhering to the Overall Layout and Specifications at http://www.lib.sfu.ca/help/writing/thesis/format. 
[bookmark: _Toc379398116][bookmark: _Ref396912613][bookmark: _Ref396912615][bookmark: _Toc418520370][bookmark: _Ref418778904][bookmark: _Toc423441567]Changing the Font of the Document
The preferred font for SFU thesis submissions is Arial 11pt. This is the default Normal font in the thesis template.
If you or your committee have a strong preference for another font, this should be changed by modifying the Normal style. For example, a supervisor may recommend using Times New Roman 12pt as specified by Chicago-Turabian style.
To modify the font of your document:
1.	Locate the Normal style in your Style Pane (see 1.3.1. How to See All the Styles).
2.	Right-click the Normal style, and select Modify…
3.	In the Modify Style dialogue box, change the font and font size in the Formatting section. Press OK.
This will change the font in almost every paragraph and header style in the whole document. The exceptions will be table styles, which are set by default to Arial Narrow. Consult the Theses Office for an appropriate font size for your table styles.
[bookmark: _Toc423441568]Paragraph Margins and Justification
The template Normal style creates justified paragraphs by default. Some citation styles (for example, MLA and Chicago) specify left-aligned paragraphs with a ragged right margin, such as this one. To change this setting, modify the Normal style as described in 4.1 and select left-alignment from the main menu or Paragraph options (see Figure 4.1). Check the requirements of your style guide before making changes.
[image: ]
[bookmark: _Toc423441605]Figure 4.1.	Changing the justification of Normal paragraphs
[bookmark: _Toc423004931][bookmark: _Toc423344904][bookmark: _Toc423349833][bookmark: _Toc423349959][bookmark: _Toc423350085][bookmark: _Toc423350211][bookmark: _Toc423350337][bookmark: _Toc379398119][bookmark: _Toc418520373][bookmark: _Toc423441569]Modifying Other Styles
If you’re interested in modifying other elements of your document, please consult the Theses Office early in your writing process. We can offer help and suggestions that may save you a lot of time and effort!
[bookmark: _Toc423441570]

Formatting for Specific Disciplines and Documents
[bookmark: _Toc423344907][bookmark: _Toc423349836][bookmark: _Toc423349962][bookmark: _Toc423350088][bookmark: _Toc423350214][bookmark: _Toc423350340][bookmark: _Toc423344908][bookmark: _Toc423349837][bookmark: _Toc423349963][bookmark: _Toc423350089][bookmark: _Toc423350215][bookmark: _Toc423350341][bookmark: _Toc379398127][bookmark: _Ref396917078][bookmark: _Ref396917082][bookmark: _Ref396917085][bookmark: _Toc418520375][bookmark: _Toc423441571]Ethics Approval for Human or Animal Research
If your research involves work with humans or animals, ethics approval is required. Ethics approval for human research is granted through the SFU Office of Research Ethics. Ethics approval for animal research is granted through the University Animal Care Committee. 
A PDF copy of the ethics approval is required when you submit your thesis to the library. In addition, the Ethics Statement must appear on page iii of the thesis, immediately after the unsigned Approval page. 
Important:
The Ethics Statement should already be included in the template as page iii. Please ensure you remove this page if you did not require ethics approval (your abstract becomes page iii).
A copy of the Ethics Statement is available on the Regulations and Forms page of the thesis website. If you need to replace the statement, go to this page and follow the instructions to download and insert the new text.
[bookmark: _Toc423441572]Education and Arts Education Theses
If your document includes multiple fonts and non-standard formatting, it is recommended that you consult the Theses Office early in the writing process for advice. 
[bookmark: _Toc379398128][bookmark: _Toc418520376][bookmark: _Toc423441573]MFA Projects
Please consult with your senior supervisor and view previous theses from your department (http://summit.sfu.ca/) to view examples of document format. There is a strong preference among MFA students to use the unnumbered thesis template. An MFA project is typically structured as follows:
Chapter 1: Artist statement  (Chapter 1. Heading 1)
Subsections, if used (Heading 2, Heading 3 … )
Bibliography (Heading 2)
Chapter 2: Project documentation (Chapter 1. Heading 1)
May include images, slides, script and other documentation
Appendix: Research paper (Heading 1_Appendix(es))
Subsections, if used (Heading 2_Appendix(es), Heading 3_Appendix(es))
Bibliography (Heading 2_Appendix(es))
Additional appendices: Documentation of supplementary files, if used. (See 2.7.4, Supplementary Material) (Heading 1_Appendix(es))
For top-level headings that do not show the word “Chapter” or a number, substitute Heading 1_References for Chapter 1. Heading 1.
[bookmark: _Toc379398130][bookmark: _Toc418520378][bookmark: _Toc423441574]Scripts and Screenplays
The 9_ styles are designed for theatre and other scripts. Some examples of the uses and formatting of the styles are as follows:
Characters:	Type character’s name, [Tab] and description.
Apply the 9_Plays_CharacterList style to the paragraphs.
For a play’s introduction, use the 9_Plays_Introduction style.
[Name]:	For the script/dialogue, type the character’s name, [Tab], and the dialogue. Apply the 9_Play_ScriptDialogue_HangingIndent style.
If you wish specific text to start on the next line, insert a line break [Shift]+[Enter].
Stage directions use the 9_Plays_StageDirections style.
There is also a stage direction Interjection style for when direction needs to be inserted within a single character’s dialogue. For such situations, use the 9_Plays_StageDirections_Interjection style.
A centred style (9_Plays_TheEnd) can be used for ending the play with
THE END.
Conventional practice for formatting screenplays is to use Courier 12pt as the font. See 4.1 Modifying Styles, for information on modifying a style for a different font.
[bookmark: _Toc379398131][bookmark: _Ref396473889][bookmark: _Toc418520379][bookmark: _Toc423441575]Extended Essays
Extended Essays are submitted for some Master’s degrees and usually consist of two unconnected essays. There is no overall introduction and conclusion to the document.
[bookmark: _Toc379398132][bookmark: _Toc418520380][bookmark: _Toc423441576]Title Page
Type each essay title in its own paragraph at the top of the page (each in its own paragraph), with and in its own paragraph between them.
Apply the 1_TP_TitleExtEssaysONLY style to each title paragraph
Apply the 1_TP_TitleExtEssays_”and” style to the and paragraph
Ensure your title page reads “Extended Essays Submitted in Partial...” where appropriate.
[bookmark: _Toc379398134][bookmark: _Toc418520381][bookmark: _Toc423441577]Document Structure
Though for the most part the two essays can be formatted as directed in these instructions, you may choose one of two document structures.
[bookmark: _Toc418520382][bookmark: _Toc423441578]Each Essay as a Chapter
Simply use the template as described in these instructions. Both essay’s titles have the Chapter 1. Heading 1 style applied, with sub-headings styled with 1.1. Heading 2/Heading 2, 1.1.1. Heading 3/Heading 3, etc. (see 2.2.1. Heading Styles). You can use all other styles as directed in these instructions. 
[bookmark: _Toc418520383][bookmark: _Toc423441579]Each Essay as a Part
This structure places the title of each essay on its own page, followed by the sub-headings and main body text. For each essay:
1.	Type your essay title, for example: 
Part 1: [Shift]+[Enter] Title of the Essay
2.	Apply the 8_Heading 1_PartsOrEssayTitles style to the essay title. This style centres the essay title on the page both vertically and horizontally. 
3.	Apply the Chapter 1. Heading 1 style for each “chapter” in each of your essays (e.g., Introduction, Literature Review, Method, Results, Discussion), 1.1. Heading 2/Heading 2 for major headings, 1.1.1. Heading 3/Heading 3 for sub-headings, etc.
4.	Use all other styles as directed in these instructions.
If you’d like to make the essay title more prominent in your ToC, before final PDF generation and submission to the library you can select each select the line-entry for each Essay and apply the ToC 1_PartsOrEssayTitles style. 
[bookmark: _Toc379398137][bookmark: _Ref396473890][bookmark: _Toc418520384][bookmark: _Toc423441580]A Cumulative Thesis or Compilation of Articles/Papers
Masters or doctoral students writing a thesis that includes a number of articles/papers must include both an overall introduction and conclusion that connect the articles. 
[bookmark: _Toc379398138][bookmark: _Toc418520385][bookmark: _Toc423441581]Document Structure
The Introduction, each of the article titles, and the conclusion would all have the Chapter 1. Heading 1 style applied to them, and then main sub-headings, the 1.1. Heading 2/Heading 2 style, and so on. If you don’t want the overall Introduction and Conclusion to be numbered, apply the Heading 1_References style to the titles.
[bookmark: _Toc423344920][bookmark: _Toc423349849][bookmark: _Toc423349975][bookmark: _Toc423350101][bookmark: _Toc423350227][bookmark: _Toc423350353][bookmark: _Toc423441582]Research Projects and Capstones
[bookmark: _Toc423441583]REM Projects
School of Resource & Environmental Management (REM) students must add the report number to the title page and approval page.
Title Page
1.	The title page should read “Research Project Submitted in Partial Fulfillment of the Requirements for the Degree of Master of Resource Management.”
2. 	At the end of the above statement, press [Enter] to create a new paragraph.
3. 	Type in your report number in the format of: Report No. ####
4. 	Apply the 1_TP_REMstudentsOnly_ReportNo style to that paragraph.
Approval Page
1. 	Insert a row between the Title row and the Examining Committee row.
2. 	Type “Report No.:” in the first (left) column.
3. 	Type the report number (####) in the right column.
4. 	Apply the 2_Approval_REMstudentsOnly_Report### style to the right column’s text.
[bookmark: _Toc379398140][bookmark: _Toc418520387][bookmark: _Toc423441584]Non-REM Projects
Masters students submitting a research project or capstone should apply Chapter 1. Heading 1 style to each chapter heading, the 1.1. Heading 2/Heading 2 style to the main sub-headings, and so on. Use all other styles as directed in these instructions. 
[bookmark: _Toc418520390][bookmark: _Toc423441585]

Submission and After Submission
[bookmark: _Toc379398150][bookmark: _Toc418520391][bookmark: _Toc423441586]Submit Your Thesis and Documentation to the Library
You must upload your thesis to the Thesis Registration System within three weeks of the date on your Supervisory Revision Memo, or by the end-of-semester deadline – whichever comes first.
Important:
See http://www.lib.sfu.ca/help/writing/thesis/submission/online-registration for a step-by-step guide to submitting the thesis and supplementary forms.
[bookmark: _Toc418520392][bookmark: _Toc423441587]After submission
The thesis requirement for your graduation is fulfilled once you complete the online submission to the Thesis Registration System. Your graduation will proceed on schedule as long as you have met the appropriate deadline.
After submission, your thesis enters processing stages: an intake process, which can take up to 4-6 weeks, and an audit/approval stage, which can take up to three months. The completion of the processing stages does not have to occur before the submission deadlines, and does not delay graduation. For more information about what happens after you submit to the Library, please see http://www.lib.sfu.ca/help/writing/thesis/after-submission.
[bookmark: _Toc379398156][bookmark: _Toc418520393][bookmark: _Toc423441588]Appendix A.	

Thesis Template: Important Licensing Information
The styles found within this document have been modified from those created by Joanie Wolfe, in accordance with CC BY-NC 2.5 CA. The Intellectual Property present in SFU’s template-based file belong to Joanie Wolfe and are licensed via Creative Commons Attribution-NonCommercial 2.5 Canada (CC BY-NC 2.5 CA) (http://creativecommons.org/licenses/by-nc/2.5/ca/). 
When text from this document is copied and pasted to other documents it will retain the unique styles from the template. If you plan to use some, or all, of your thesis for commercial purposes, you must first release your text from the styles.
To release your text from this licence agreement: 
1. 	select the text;
2. 	apply the Normal style; 
3. 	copy the text;
4. 	open a new blank document; 
5. 	paste that text into the new document; and  
6. 	after doing so, check the Style Window/Pane/Panel/Toolbox to be sure that the styles that begin with numbers are not present.
Following the above steps will ensure that you are respecting this licence agreement. 
The 6 steps above are also in the Document Properties, so you can locate them again at a later date. 
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